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Penyelesaiannya : 

a STATUS : 

=VLOOKUP(LEFT(B15,1),TABEL1,2) 

b JABATAN : 

=IF(MID(B15,2,1)="1","Gold",IF(MID(B15,2,1)="2","Senior1”,IF(MID(B15,2,1)= "3","Senior 

2","Distributor"))) 

c NAMA BARANG : 

=VLOOKUP(VALUE(RIGHT(F15;4));TABEL2;2;0) 

d BONUS POINT : 

=VLOOKUP(VALUE(RIGHT(F15;4));TABEL2;4;0) 

e JUMLAH PENJUALAN : 

=I15*(VLOOKUP(VALUE(RIGHT(F15;4));TABEL2;3;0)) 

f JUMLAH B.P (BONUS POINT) 

=H15*I15 
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Praktek Bab 1 
 

1. Buatlah Tabel di bawah ini, lalu simpan dengan nama file Modul1-NimAnda.xlsx 

 
2. Isi dengan ketentuan : 

a. Jenis Bunga diisi dengan Lookup dari Tabel bunga 

b. Harga diisi dengan Lookup dari Tabel bunga 

c. Total Harga diisi dengan Jumlah dikali Harga 

d. Diskon diisi dengan Lookup Diskon dari tabel Diskon dikali Total Harga 

e. Total Bayar diisi dengan Total Harga dikurangi Diskon 

f. Format data di atas dalam Format Rupiah 

 

Sehingga Hasilnya: 
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Gambar 2.1 Tampilan Customize Options 

 

Mengisi data dengan menggunakan data form yaitu : 

a. Ketikan Nama Field misal: 

 
b. Pilih dan klik salah satu nama field, misal NIM 

c. Klik Tombol Form    yang ada di Quick Access Toolbar 

d. Klik Ok, sehingga akan muncul Kotak dialog seperti dibawah ini. 



Disusun Oleh : Rani Susanto, S.Kom 

6 

 
Gambar 2.2 Tampilan New Record 

 

e. Kemudian  ketikan data yang akan dimasukan. Untuk pindah ke judul kolom berikutnya 

gunakan tombol TAB. 

Catatan 

 New   : Untuk menambah data/record baru 

 Delete  : Untuk menghapus data/record yang aktif 

 Restore : Untuk membatalkan pengisian data 

 Find Prev : Untuk berpindah ke record sebelumnya 

 Find Next : Untuk berpindah ke record berikutnya 

 Criteria : Untuk mencari record tertentu yang memenuhi kriteri 

 Close  : Untuk menutup kotak dialog form dan kembali ke lembar kerja. 

 

Fungsi Statistik Database 
 

Daftar fungsi statistik database terdapat pada Ribbon Formulas > Insert Function, 

sehingga tampak tampilan seperti berikut.  
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Gambar 2.3 Tampilan Insert Function 

 

Ciri pada sebuah fungsi statistik database adalah diawali dengan karakter “D” pada setiap 

nama masing-masing nama fungsi. 

Terdapat dua belas fungsi statistik database yang dapat dimanfaatkan untuk mengoperasikan 

data dalam tabel kerja. Tetapi tidak semua fungsi akan dibahas, diantaranya adalah : 

 

1. Fungsi DSUM 
Fungsi DSUM digunakan untuk menjumlahkan nilai dari data yang ada di dalam kolom 

field pada range database berdasarkan ketentuan yang diberikan oleh kriteria. Bentuk penulisan 

fungsi DSUM : 

 

= DSUM(Database,Field,Criteria) 

Keterangan 

• Database : adalah alamat range database yang tidak lain adalah tabel kerja yang memuat data. 

Range meliputi judul data. 

• Field :  adalah alamat field yang digunakan 

• Criteria : adalah alamat range kriteria (kondisi yang merupakan syarat yang membatasi 

pengoperasian data. Kriteria dapat berupa rumus logika atau range yang memuat suatu kondisi. 
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2. Fungsi DAVERAGE 
Fungsi DAVERAGE digunakan untuk menghitung nilai rata-rata dari data yang ada di 

dalam kolom field pada range database berdasarkan ketentuan yang diberikan oleh kriteria. Bentuk 

penulisan fungsi DAVERAGE : 

 

= DAVERAGE(Database,Field,Criteria) 

 

3. Fungsi DMAX 
Fungsi DMAX digunakan untuk menampilkan data dengan nilai terbesar (tertinggi) di 

dalam kolom field pada range database berdasarkan ketentuan yang diberikan oleh kriteria. Bentuk 

penulisan fungsi DMAX : 

 

= DMAX(Database,Field,Criteria) 

 

4. Fungsi DMIN 
Fungsi DMIN digunakan untuk menampilkan data dengan nilai terkecil (terendah) di dalam 

kolom field pada range database berdasarkan ketentuan yang diberikan oleh kriteria. Bentuk 

penulisan fungsi DMIN : 

 

= DMIN(Database,Field,Criteria) 

 

5. Fungsi DCOUNTA 
Fungsi DCOUNTA digunakan untuk menghitung jumlahsel yang memuat data yang ada di 

dalam kolom field pada range database berdasarkan ketentuan yang diberikan oleh kriteria. Bentuk 

penulisan fungsi DCOUNTA 

= DCOUNTA(Database,Field,Criteria) 
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Praktek Bab-2 
 

Buatlah daftar gaji pegawai RETRO ADVERTISING dibawah ini pada sheet1 lalu simpan dengan 

file latihan1. 

DAFTAR GAJI PEGAWAI 
RETRO ADVERTISING 

 
NAMA NIP BAGIAN ALAMAT GAJI 

Nova Aryani M-10001 Keuangan Dipatiukur No 243 800000 
Linda Sidabutar M-10002 Personalia Dayeuh Kolot No 23 650000 
Bambang M-10003 Pemasaran Cimahi No 25 700000 
Syarif Husen M-10004 Keuangan Veteran No 8 800000 
Yanti Astuti M-10005 Keuangan Otista No 9 800000 
Dina Olivia M-10006 Pemasaran Banteng No 78 650000 
Deni Ahmad M-10007 Personalia Moch. Toha No 5 650000 
Budi Saptoaji M-10008 Gudang Pungkur No 56 500000 
Angga Wijaya M-10009 Produksi Soekarno-Hatta No 7 550000 
Anisa Fitri M-100010 Personalia Menggar No 5 650000 
Kamal  M-100011 Pemasaran Dago No 78 700000 
Uus Sulaeman M-100012 Produksi Titiran No 32 550000 
Rudi Aryanto M-100013 Personalia Dipatiukur No 45 650000 
Dendi Arga M-100014 Gudang Banteng No 6 500000 
Nadia  M-100015 Keuangan Palasari No 5 800000 

 
 
NAMA JUMLAH 

GAJI 
GAJI RATA-

RATA 
JUMLAH 

PEGAWAI
GAJI 

TERBESAR 
GAJI 

TERKECIL
      
 

Petunjuk 
a. Tampilkan NAMA pegawai yang berawalan N 

b. Tampilkan Jumlah Gaji 

c. Tampilkan Gaji Rata-rata 

d. Tampilkan Jumlah Pegawai 

e. Tampilkan Gaji Terbesar 

f. Tampilkan Gaji Terkecil 

 

Penyelesaian 
a. Pada sel A23 isikan teks N* 

b. Pada sel B23 isikan rumus =DSUM(A4:E19;E4;A22:A23) 

c. Pada sel C23 isikan rumus =DAVERAGE(A4:E19;E4;A22:A23) 

d. Pada sel D23 isikan rumus =DCOUNT(A4:E19;E4;A22:A23) 
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e. Pada sel E23 isikan rumus =DMAX(A4:E19;E4;A22:A23) 

f. Pada sel F23 isikan rumus =DMIN(A4:E19;E4;A22:A23) 

 

Dan hasilnya seperti pada gambar di bawah ini : 
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Latihan Bab-2 
 

1. Dari tabel kerja di atas kerjakan soal-soal di bawah ini : 

a. Tampilkan Informasi mengenai NAMA pegawai yang huruf keempatnya adalah A  

b. Tampilkan informasi mengenai pegawai yang BAGIAN kerjanya di bagian personalia 

c. Tampilkan informasi mengenai pegawai yang BAGIAN kerjanya di bagian personalia 

dan Pemasaran 

d. Tampilkan informasi mengenai pegawai yang ALAMAT kerjanya di Dipatiukur 

e. Tampilkan informasi mengenai pegawai yang GAJI pegawainya antara > 600000 

f. Tampilkan informasi mengenai pegawai yang GAJI pegawainya antara < 700000 

g. Simpan File tersebut dengan Nama File Modul2-NimAnda.xlsx 

 

2. Buka kembali Praktek Modul 1, lalu kerjakan soal dibawah ini : 

a. Tampilkan Informasi mengenai Jenis Bunga yang berjenis Lokal 

b. Tampilkan Informasi dengan Total bayar >= 500000 
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Keterangan 
Perintah Keterangan 

Equals Sama dengan 

Does not equal Tidak sama dengan 

Is grather than Lebih besar 

Is grather than or equal to Lebih besar atau sama dengan 

Is less than Lebih kecil 

Is less than or equal to Lebih kecil atau sama dengan 

Begins with Diawali dengan  

Does not begin with Tidak diawali dengan 

End with Diakhiri dengan 

Does not end with Tidak diakhiri dengan 

Contains Berisi 

Does not contain Tidak berisi 

 

Untuk membentuk penulisan kriteria yang memiliki nilai – nlai tertentu, maka dapat digunakan 

karakter wildcard yang terdiri dari : 

 

• Karakter *  : digunakan untuk mewakili penulisan beberapa karakter sembarang dalam 

posisi yang sama 

• Karakter ? : digunakan untuk mewakili penulisan sembarang karakter tunggal dalam 

posisi yang sama. 

 

Menyaring Database dengan Advanced Filter 
 

Untuk menyaring database dengan kriteria yang kompleks dapat dilakukan dengan perintah 

Advanced Filter. Pada Advanced Filter tidak menampilkan daftar kriteria, tetapi harus ditentukan 

kriteria tersebut pada worksheet dengan range kriteria. Dengan menggunakan fasilitas tersebut 

maka penyaringan dapat dilakukan dengan lebih cepat Langkah-langkah yang bisa dilakukan yaitu 

sebagai berikut : 

 

a. Tentukan kriteria yang diinginkan pada nama field 

b. Klik menu Data > Filter > Advanced Filter sehingga muncul kotak dialog seperti di bawah ini  
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Gambar 4.2. Form Create PivotTable 

 

Tekan tombol OK, lalu akan menghasilkan layout seperti di bawah ini : 

 
Gambar 4.3. Form PivotTable 
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Lakukan modifikasi bentuk tabel pivot sesuai dengan kriteria yang diinginkan pada tabel pivot 

layout. 

Pada bagian Pivot Table Field List terdapat 2 buah menu yaitu : 

1. Choose fields to add to report 

Bagian ini berisi pilihan menu dari judul kolom yang sudah kita buat di tabel sebelumnya.  

2. Drag fields between areas below 

- Report Filter : beirisi Judul dari Laporan 

- Column Labels : Menempatkan judul di bagian kolom 

- Row Labels : menempatkan di bagian baris 

- Values : berisi nilai yang kita tentukan. Bisa berupa operator matematika 

Untuk itu lakukan beberapa hal dibawah ni: 

1. Drag field SALESMAN pada bagian Row Labels 

2. Drag field TYPE pada bagian Column Labels 

3. Drag field JUMLAH dan HARGA pada bagian Values 

 
Gambar 4.4. Hasil PivotTable 

 

Gambar diatas menunjukkan bahwa telah dibuat tabel yang berisi tampilan data berdasarkan 

Salesman.  
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Pada Ribbon Pivot Table Tools terdapat 2 buah ribbon pilihan yaitu Options dan Design. Salah 

satu tools yang ada di Options adalah Refresh yang nantinya akan kita gunakan untuk merefresh 

atau menyegarkan setiap perubahan yang terjadi pada tabel yang telah kita buat. 

Sedangkan pada Ribbon Design terdapat 3 buah pilihan yaitu : 

1. Layout 

- Sub Totals : untuk menampilkan atau tidak menampilkan sub total dari table. 

- Grand Totals : untuk menampilkan atau tidak menampilkan grand total dari table 

- Report Layout : untuk menentukan tampilan layout tablenya seperti apa 

2. Pivot Table Style Options 

3. Pivot Table Styles 

 

Praktek Bab-4 
 

Buatlah Data penjualan barang seperti di atas pada sheet1 lalu simpan dengan file Modul4-

NimAnda.xlsx 

 

Latihan Bab-4 
 

Dari tabel kerja di atas kerjakan soal-soal di bawah ini : 

a. Tampilkan data SALESMAN berdasarkan DAERAH Bandung 

b. Tampilkan data SALESMAN berdasarkan BULAN Februari dan DAERAH Jakarta. 

Untuk Bulan dibuat menjadi Page (halaman) baru. 

c. Tampilkan data SALESMAN berdasarkan BULAN Januari. 

d. Tampilkan masing-masing data SALESMAN 

e. Ubah fungsi SUM pada JUMLAH menjadi fungsi MAX 

f. Ubah fungsi SUM pada JUMLAH menjadi fungsi AVERAGE 

g. Ubah fungsi SUM pada HARGA menjadi fungsi MIN 
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Gambar 5.7 Tampilan Excel Option 

 

Dari enam sheet tersebut dapat dibuat tabel pivot dengan beberapa field halaman. Langkah-langkah 

yang dilakukan  seperti di bawah ini : 

a. Aktifkan sheet KW1-02. Klik menu Pivot Table and Pivot Chart Report Wizard. Kotak 

dialog Pivot Table and Pivot Chart Report Wizard sebagai langkah pertama seperti di 

bawah ini : 

 
Gambar 5.8. Kotak dialog Pivot Table Wizard Step 1 
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b. Tentukan jenis sumber data yang akan dioperasikan. Aktifkan tombol pilihan pada Multiple 

Consolidation Ranges, dan Pivot Table > Next 

c. Tentukan jenis sumber data yang akan dioperasikan. Aktifkan tombol pilihan pada Multiple 

Consolidation Ranges, dan Pivot Table > Next 

 

 
          Gambar 5.9. Kotak dialog Pivot Table Wizard Step 1 

 

d. Setelah menekan tombol Next akan muncul langkah 2b. Kemudian seleksi range pada tabel 

utama yang akan dijadikan sumber data pembentuk tabel pivot. Tekan tombol Add untuk 

menyimpan alamat range tersebut pada bagian All ranges 

 
Gambar 5.10. Kotak dialog Pivot Table Wizard Step 2 
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Ulangi langkah tersebut sampai semua sumber data dari ke enam sheet tersebut terpilih. 

e. Tentukan jumlah field halaman yang diinginkan. Pilih tombol pilihan 2 untuk membentuk 

dua field halaman yaitu Tahun dan Kwartal. Kemudian tentukan nama item masing-

masing field halaman. Field one di isi dengan tahun (ketik 2002 atau 2003) dan field two 

diisi dengan kwartal (ketik kwartal1, kwartal2, atau kwartal3).  

f. Setelah semua range diberi nama item halaman, tekan tombol Next sehingga berlanjut ke 

step berikutnya seperti di bawah ini : 

 
Gambar 5.11. Kotak dialog Pivot Table Wizard Step 3 

 

 
Gambar 5.12. Pivot Table Tools 
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Gambar 5.13. Hasil Pivot Table  

 

 

Latihan Bab-5 

 

Buatlah Data Laporan penjualan di atas dan buat Pivot Table nya lalu simpan dengan nama File 

Modul5-NimAnda.xlsx 
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4. Cara yang lebih cepat untuk membuat chart yaitu : 

- Sorot semua data yang akan dibuat chart 

- Lalu tekan ALT + F1 atau  F11 

- Jika Anda menekan ALT + F1 maka chart akan di tampilkan pada sheet yang sama. 

(Tidak pindah sheet baru) 

- Tapi jika anda menekan F1 maka chart akan ditampilkan pada sheet yang baru. (Nama 

sheet akan berubah menjadi Chart) 

Bagaimana cara memindahkan posisi chart. 

Anda bisa memindahkan posisi chart yang telah Anda buat dengan cara : 

1. Klik chart akan dipindahkan untuk menampilkan chart tools 

2. Pada tab Design, di group Location pilih Move Chart 

 
3. Pada kotak dialog Move Chart pilihlah dimana chart akan dipindahkan. 

a. New Sheet : ditampilkan di sheet yang baru yaitu di sheet chart 

b. Object in : disimpan di dalam sheet yang sudah ada sebelumnya. 

 
Gambar 6.3 Form Move Chart 

 

Ketika anda membuat chart, maka akan ditampilkan tools tambahan untuk chart yaitu Design, 

Layout dan Format, untuk memodifikasi chart yang sudah kita sudah buat.  

1. Design 

Di dalam ribbon Design akan ditampilkan tools: 

- Change Chart Type : mengubah jenis chart 

- Save As Template : menyimpan ke dalam bentuk template 

- Switch Row Column : mengubah posisi baris dan kolom 
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- Select Data : memilih atau mengubah data source (sumber data yang digunakan untuk 

membuat grafik) 

- Chart Layouts :  mengubah tampilan chart 

- Chart Styles : mengubah style chart (warna dsb) 

- Location : memindahkan lokasi chart 

 
Gambar 6.4 Chart Tools 

 

2. Layout 

 
Gambar 6.5 Chart Tools (Layout) 

 

3. Format 

 
Gambar 6.6 Chart Tools (Format) 
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Praktek Bab -6 (Chart) 

 

Buat Tabel di bawah ini : 

 
1. Sorot data pada tabel diatas dari sel B5 : G20 

2. Lalu tekan F11 agar chart dibuat di sheet yang baru 

3. Maka akan tampil gambar seperti di bawah ini 

 
4. Maka perbaiki tampilannya : 
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5. Pada ribbon Design, pilih Switch Row Column hingga hasil akhir chart menjadi seperti di 

bawah ini. 

6. Untuk mengubah dan memodifikasi warna dan yang lainnya anda bisa mencobanya sendiri. 

 
 

7. Simpan data di atas dengan nama File Modul6-NimAnda.xlsx 
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Hyperlink 

 

Hyperlink adalah salah satu fasilitas dalam Excel yang digunakan untuk menhubungkan antara satu 

file dengan file yang lainya. Baik dengan File Excel, file lain atau dengan halaman Web (URL). 

 

Membuat Hyperlink di File Baru 

 
Cara untuk membuat hyperlink di file yang baru yaitu : 

1. Tentukan Cell yang akan di buat Hyperlink. 

2. Pada tab Insert pada Grup Link, pilih Hyperlink  atau lakukan klik kanan, lalu pilih 

Hyperlink atau langsung tekan Ctrl+K 

 
Gambar 6.7 Insert Hyperlink 

3. Pada bagian Link to, pilih Create New Document 

 
Gambar 6.8 Create New Document 
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4. Di bagian Name of new document, tentukan nama file yang Anda inginkan 

5. Di bagian When to Edit, bisa memilih Edit the new document later atau Edit the new 

document now, untuk menentukan kapan kita akan mengedit file 

6. Di bagian text to display, tentukan nama untuk mempresentasikan Hyperlink yang akan 

dibuat 

 

 

Membuat Hyperlink di File yang sudah ada atau di halaman Web 

 

Untuk membuat Hyperlink di file excel yang baru, lakukan langkah di bawah ini : 

1. Pilih cell (baris atau kolom) yang akan dibuat hyperlink. 

2. Pada tab Insert pada Grup Link, pilih Hyperlink  atau lakukan klik kanan, lalu pilih 

Hyperlink atau langsung tekan Ctrl+K 

3. Pada bagian Link to, pilih Existing File or Web Page 

 
Gambar 6.9 Existing File or Web Page 

 
4. Di bagian Look in, ada beberapa pilihan yang bisa dipilih : 

a. Untuk memilih File, klik Current File, lalu pilih file yang ingin ditampilkan 

b. Untuk memilih halaman web, klik Browsed Pages lalu pilih halaman web yang ingin 

dihubungkan 

c. Untuk memilih file yang biasa digunakan, klik Recent Used lalu pilih file yang akan 

digunakan 
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d. Untuk menginputkan nama dan lokasi dari file atau halama web yang ingin di link kan, 

maka inputkan nama di bagian Address 

5. Di bagian Text to Display, ketikan nama yang ingin ditampilkan di Hyperlink 

 

Membuat Hyperlink ke Lokasi yang lain di dalam Worksheet 

 

Untuk membuat Hyperlink di dalam worksheet yang sama, kita harus menentukan dulu nama dari 

daerah tujuan yang akan dihasilkan oleh Hyperlink. 

1. Berikan nama untuk daerah hasil. Pilih Cell, Formulas, Define Names 

2. Di sheet yang menjadi sumber/awal datanya. Pilih cell yang akan diHyperlink kan 

3. Pada tab Insert pada Grup Link, pilih Hyperlink  atau lakukan klik kanan, lalu pilih 

Hyperlink atau langsung tekan Ctrl+K 

4. Pada bagian Link to, pilih Place in This Document 

 
Gambar 6.10 Place in This Document 

5. Di bagian Or Select a place in this Document. Lihat Cell reference, pilih sheet atau nama 

Sheet yang ingin ditampilkan 

6. Di bagian text to display, ketikan nama untuk merepresentasikan Hyperlink 
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Membuat Hyperlink menuju Alamat E-Mail 

 

Untuk membuat Hyperlink menuju alamat e-mail tertentu, lakukan langkah di bawah ini. 

1. Pilih cell (baris atau kolom) yang akan dibuat hyperlink. 

2. Pada tab Insert pada Grup Link, pilih Hyperlink  atau lakukan klik kanan, lalu pilih 

Hyperlink atau langsung tekan Ctrl+K 

3. Pada bagian Link to, pilih E-Mail Address 

 
Gambar 6.11 E-mail Address 

4. Dibagian E-mail address : ketikan alamat e-mail yang dituju 

5. Dibagian Subject : ketikan subjek dari mail yang ingin dikirimkan 

7. Dibagian Text to display : ketikan nama untuk merepresentasikan Hyperlink 

 

Menghapus Hyperlink 

 

Untuk menghapus Hyperlink, lakukan hal di bawah ini : 

1. Untuk menghapus Hyperlink secara permanen, pilih cell yang mengandung hyperlink, klik 

kanan lalu klik Clear Content 

2. Untuk mengembalikan hyperlink menjadi bentuk teks biasa, pilih cell yang mengandung 

hyperlink, klik kanan, klik Remove Hyperlink 
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Praktek Bab-6 (Hyperlink) 

 

Pada Sheet 2 di File yang sama (Chart), buatlah beberapa link untuk menuju ke : 

1. Praktek Modul 1 

2. Praktek Modul 2 

3. Praktek Modul 3 

4. Praktek Modul 4 

5. Praktek Modul 5 

6. Sheet 1 File Chart 

7. Ke Halaman situs : www.google.com 

8. Ke halaman situs : www.facebook.com 

9. Kirim email ke email anda sendiri. 

10. Sehingga tampilan nya sebagai berikut. 

 

 


